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Uvod i općenito o aplikaciji Google Wave 
 

U rujnu 2009. imali smo se prilike upoznati sa još jednim proizvodom tvrtke Google: aplikacijom 

Google Wave. Što je to – pitamo se.  

Novi chat, e-mail, wiki ili ne-daj-bože novi Facebook? Odgovor je od svega pomalo. Wave je naime, 

dizajniran da spoji e-mail, instant poruke, wiki i socijalne mreže. 

Google je Wave opisao kao web alat za komunikaciju i suradnju. Opis se poprilično slaže sa mojim 

dosadašnjim iskustvima. Ipak za svakidašnju komunikaciju više koristim alate kao što su Gtalk ili 

Skype, što bih pripisao njihovoj jednostavnosti korištenja. Ljepote koje Wave donosi ipak imaju 

cijenu: Wave ponekad voli „pojesti“ dobar dio radne memorije ili pak zagušiti internet vezu, a tu i 

tamo se „zamrzne“. Doduše, još uvijek se radi o verziji proizvoda za pregled, pa de možda u 

bududnosti neke stvari bolje funkcionirati. Što se tiče suradnje, Wave je na tom području jedno 

sasvim ugodno iskustvo (čak je i ovaj tekst nastao uz pomod aplikacije Wave).  

Prilikom rada na zajedničkom projektu ili rješavanju zadataka sa kolegama, do izražaja jako dolaze 

novosti koje donosi Wave. Tako možemo umetnuti odgovor, reply, u bilo koji dio cijelog razgovora, 

nazvanog wave. Također možemo naknadno uređivati bilo koji dio wave razgovora. 

Važno je i napomenuti da se konverzacija događa „uživo“, pa možemo gotovo istovremeno vidjeti što 

naš Wave-sugovornik tipka, čime su zadržane neke važne odlike „pravog“, stvarno razgovora lice-u-

lice kao što je upadanje u riječ. 

Sve promjene na wave razgovoru se snimaju pa, ako se kasnije uključimo u neki wave, možemo uz 

pomod ponovnog prikaza, playbacka, odvrtjeti cijelu konverzaciju. Za tu opciju nismo pronašli neku 

korisnu uporabu zbog koje bi je redovito koristili. Dodatno, nešto vedeg broja postova (jezikom 

Google Wave blipova) ponovni prikaz postajespor. Wave podržava i razne oblike multimedije, pa 

možemo u wave razgovor umetati slike, video, hiperpoveznice, te druge sadržaje. 

Google planira vedinu aplikacije Wave objaviti kao open source. U ovom trenutku dostupan je njegov 

API. Time se omoguduje korisnicima samostalan razvoj aplikacije u vidu ekstenzija. Ekstenzije su način 

na koju proširujemo funkcionalnost same aplikacije Wave, a dijele se na Gadgete i Robote. Gadget je 

dijeljeni program, koji se „vrti“ unutar samog wave razgovora i dostupan je svim njegovim 

sudionicima. Robot je s druge strane automatizirani aktivni sudionik wave razgovora. Dakle, može 

sudjelovati u razgovoru u skladu sa svojim mogudnostima i provoditi automatizirane zadade. 

Kako bismo bolje upoznali Google Wave aplikaciju, u sklopu projektnog zadatka odlučili smo pokušati 

napraviti ekstenziju, točnije robota,za Wave koji bi obrađivao LaTeX kôdove za matematičke formule. 

Ideja nam se činila izazovna, poučna i korisna. Izazovna i poučna je bila, a vrijeme de pokazati da li je i 

korisna.  

  



Texmakey 
 

Texmakey je Google Wave robot koji služi lakšem unošenju matematičkog teksta u Wave. U tekstu 

wave razgovora pronalazi LaTeX kôd koji je okružen sa „dvostrukim dolarima“, to jest znakovima '$$', 

i pretvara ga u slike koje prikazuju formule zadane kôdom. Na primjer: 

 

Nakon što smo postavili razvojno okruženje za Google Wave robota, prema tutorialu 

(http://code.google.com/apis/wave/extensions/robots/java-tutorial.html) u programu Eclipse 

kreiramo novi projekt klikom na „New Web Application Project“. Kreirani projekt sadrži sve mape i 

datoteke koje su nam potrebne. Potrebno je urediti nekoliko datoteka kako bi naš robot proradio. 

web.xml  
Datoteka u kojoj definiramo ime našeg robota i njegov aplikacijski ID. 

capabilities.xml 
Datoteka u kojoj definiramo koju vrstu događaja naš robot zna obrađivati. Neke od opcija su 

WAVELET_PARTICIPANTS_CHANGED (kada se promjene sudionici Wave-a), WAVELET_SELF_ADDED 

(kada je robot dodan u Wave) ili BLIP_SUBMITTED (kada je dodan novi blip u Waveu). 

TexmakeyServlet.java 
Datoteka u kojoj se nalazi glavni posao koji robot obavlja u wave razgovoru. Kôd je pisan u 

programskom jeziku Java, i sastoji se od funkcija koje su pozvane na određeni događaj koji smo 

definirali u datoteci capabilities.xml. Ovdje je primjer funkcije koja se poziva kad korisnici unesu novi 

post. 

 
//ako je trenutni događaj događaj unošenja posta 

if (e.getType() == EventType.BLIP_SUBMITTED) { 

 //dohvati post 

 Blip inputBlip = e.getBlip(); 

 //dohvati sadržaj posta 

 TextView inputDocument = inputBlip.getDocument(); 

 //dohvati tekst posta 

 String inputText=inputDocument.getText(); 

 //podijeli tekst posta na dijelove između '$$' 

 String[] niz = inputText.split("\\$\\$"); 

 //obriši sadržaj posta 

 inputDocument.delete(); 

 //za sve dijelove teksta 

http://code.google.com/apis/wave/extensions/robots/java-tutorial.html


 for (int i=0; i < niz.length; i++){ 

  //ako se nalaze na parnom mjestu, onda je to običan tekst 

  //pa ga jednostavno dodamo na rezultat 

  if (i % 2 == 0) inputDocument.append(niz[i]); 

  //inače je to latex kod 

  else { 

   Image latexSlika = new Image(); 

   //pošaljemo taj kod serveru koji nam vrati sliku 

   latexSlika.setUrl(" 

http://www.forkosh.dreamhost.com/mathtex.cgi?". 

concat(niz[i])); 

/   /dodamo sliku na sadržaj dokumenta 

   inputDocument.appendElement(latexSlika); 

  } 

 } 

} 

 

Cjeloviti izvorni kôd robota možemo dohvatiti na adresi 

http://multimedijskisustavi.googlecode.com/files/Texmakey.zip. 

Razvojno okruženje 

 
Robote je mogude razvijati (barem zasada) u dva programska jezika – Java i Python. Mi smo se 

odlučili za razvoj u Javi, što znači da smo koristili Java Client Library. 

Za razvoj u Javi, prije svega je potreban Java 6 development kit. Zatim je sa adrese 

http://code.google.com/p/wave-robot-java-client/ potrebno preuzeti Java client library, JSON library 

i JSON RPC library. 

Robote možete razvijati u vašoj omiljenoj Java razvojnoj okolini, ali Google preporuča da se koristi 

Eclipse IDE uz instalaciju Google Plugina za Eclipse. 

Svakako je potrebno registrirati svoj Application ID, preko kojega dete razvijati, testirati i koristiti vaš 

robot. Pojedinac može registrirati do 10 App ID-eva, stoga je najbolje jedan ID ostaviti za razvojne 

potrebe. 

Application ID možete zatražiti na adresi https://appengine.google.com/. 

Postavljanje Eclipse razvojnog okruženja 
Preuzmite i instalirajte Eclipse sa web stranice http://www.eclipse.org/. Pri tome je važno da 

preuzmete Java EE paket, koji uključuje nekoliko korisnih funkcionalnosti za razvoj web aplikacija. 

Google Plugin i App Engine SDK možete preuzeti iz samog Eclipsea koristedi ugrađenu funkciju 

Software Update. 

Kao lokaciju s koje preuzimate navedene pakete unutar Software Update dijaloga koristite sljedede 

web adrese: 

http://dl.google.com/eclipse/plugin/3.5 - za Eclipse 3.5 (Galileo) 

http://multimedijskisustavi.googlecode.com/files/Texmakey.zip
http://code.google.com/p/wave-robot-java-client/
http://www.eclipse.org/
http://code.google.com/eclipse/
https://appengine.google.com/
http://www.eclipse.org/
http://dl.google.com/eclipse/plugin/3.5


http://dl.google.com/eclipse/plugin/3.4 - za Eclipse 3.4 (Ganymede) 

Potrebno je odabrati Google Plugin i SDK iz popisa dostupnog softvera i zatim ih instalirajte. Mogude 

su poruke o greškama o kojima više pročitajte u dijelu „Problemi s kojima smo se susreli“. 

Sada ste spremni za stvaranje novog projekta: 

1. Odaberite File > New > Web Application Project. 

2. Otvoriti de se dijalog "Create a Web Application Project". Pod "Project name" unesite naziv vašeg 

projekta, poput MojRobot. Pod "Package" unesite prikladni naziv paketa MojRobot. 

3. Ako za svoj projekt nedete koristiti Google Web Toolkit, ukinite oznaku u polju "Use Google Web 

Toolkit." Uvjerite se da je označeno "Use Google App Engine". 

4. Za stvaranje projekta pritisnite Finish. 

Eclipse de stvoriti strukturu direktorija projekta, uključujudi direktorij src/ za Java izvorne datoteke i 

direktorij war/ za kompilirane klase i ostale datoteke za aplikaciju, biblioteke, konfiguracijske 

datoteke, statične datoteke i datoteke s ostalim podacima. Također de biti stvorena servlet izvorna 

datoteke i dvije konfiguracijske datoteke. Potpuna struktura direktorija izgleda ovako: 

MojRobot/  

src/  

mojrobot/  

server/  

ParrotyServlet.java  

META-INF/  

jdoconfig.xml  

log4j.properties  

logging.properties  

war/  

WEB-INF/  

lib/  

...App Engine JAR datoteke...  

appengine-web.xml  

web.xml  

index.html 

 

Konačno, da biste krenuli s razvojem robota, potrebno je ovu aplikaciju pretvoriti u robota, a za to 

trebate Java robot application biblioteku iz Wave Extensions SDK. Također su vam potrebne JSON 

biblioteke koje su također isporučene unutar SDK. 

Navedene biblioteke se nalaze u sljededim JAR datotekama: 

http://dl.google.com/eclipse/plugin/3.4
http://code.google.com/webtoolkit/


 wave-robot-api.jar 

 json.jar 

 jsonrpc.jar 

Kopirajte te datoteke iz SDK u sljededi direktorij unutar vašeg projekta: MojRobot/war/WEB-INF/lib/ 

Osvježite projekt tako da kliknete File > Refresh. Odaberite Project > Properties, zatim u prozoru 

Properties odaberite kategoriju "Java Build Path". Pritisnite karticu "Libraries", zatim pritisnite gumb 

Add JARs.... Pronađite i odaberite nove JAR datoteke, zatim pritisnite OK. Pritisnite OK za zatvaranje 

prozora Properties. 

Sada je razvojno okruženje pripremljeno za razvoj robota, pa možete krenuti s razvojem.  

Problemi s kojima smo se susreli 
 

Instalacija 
Kako bismo počeli s izradom Google Wave robota, prvo je bilo potrebno osigurati okruženje za razvoj 

u kojem demo izrađivati robot. 

Koristili smo upute koje je Google objavio na stranici Google Wave Robots: Java Tutorial 

(http://code.google.com/apis/wave/extensions/robots/java-tutorial.html). Stranica preporuča 

korištenje Eclipse razvojnog okruženja u kombinaciji sa dodatkom „Google Plugin for Eclipse“. No 

Eclipse stranica nudi više različitih izdanja svog razvojnog okruženja. Odabrali smo „Eclipse Classic 

3.5.1“ (jedan od najvedih paketa, uključuje i Java Development Tools). 

Slijededi daljnje upute sa stranice http://code.google.com/appengine/docs/java/tools/eclipse.html, 

pokušali smo skinuti dodatak „Google Plugin for Eclipse“. Dodali smo 

http://dl.google.com/eclipse/plugin/3.5 u lokacije za osvježavanje programa Eclipse. Potom smo 

pokrenuli skidanje i dobili nedeskriptivne greške o neuspješnoj instalaciji. Pretraživanjem foruma 

otkrili smo da je potrebno dodati još jednu lokaciju; http://download.eclipse.org/releases/galileo. 

 

Kasnije smo otkrili i stranicu postavljenu od Googlea sa rješenjem tog problema na adresi 

http://code.google.com/eclipse/docs/faq.html (pitanje „During installation, there's an error about 

requiring org.eclipse.wst.sse.ui. How do I fix that?“). 

Nakon instalacije, slijedili smo dalje upute i uspjeli dobiti predložak za prvi robot. Predložak ima 

nekoliko desetaka datoteka, od kojih je bilo potrebno izmijeniti više konfiguracijskih datoteka. Sâm 

program sadržaj je u jednoj java datoteci. 

Application ID 
Potrebno je prvo registrirati application ID. Jedan korisnik može registrirati do 10 application ID-ova. 

Registracije se ne mogu poništiti, obrisati ni promijeniti nakon registracije. Google preporuča 

korištenje jedne registracije za testiranje i „korištenje application ID samo kada znate da dete koristiti 

u bududem projektu“. 

http://code.google.com/apis/wave/extensions/robots/java-tutorial.html
http://code.google.com/appengine/docs/java/tools/eclipse.html
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http://code.google.com/eclipse/docs/faq.html


Pri registraciji potrebno je dati svoj broj mobitela Googleu – podaci o registraciji dolaze u obliku SMS 

poruke. 

Velika zamjerka application ID registracija je da su vezane uz korisničko ime – stoga se mora 

registrirati posebni Google račun kojemu svi članovi razvojnog tima moraju znati lozinku ili pak svaki 

član mora stvoriti svoj testni application ID i na neki način sinhronizirati trenutnu inačicu kôda. 

Korištenje 
Ubrzo je uslijedio drugi problem – robot je nemogude testirati u izvanmrežnom načinu rada. Slijededi 

upute, za svaku promjenu šaljemo sve datoteke iz projekta na Googleov server, ne samo datoteku 

koja je izmijenjena ili u kojoj se sadrži programski kod. 

Slanje zna potrajati i po pola minute. To se ne čini kao dugo vrijeme – no pomnožimo ga s brojem 

slanja, te pribrojimo frustraciju čekanja i ubrzo nam dozlogrdi i slanje i roboti i Google koji obedava 

„samo-što-nije“ lokalno testiranje. 

Zaključak 
 

Uspjeli smo napraviti i postaviti robota koji radi. Nije bilo lako i susreli smo se s mnogo problema, od 

instalacija preko implementacije pa do testiranja i debuggiranja. Prvo korištenje nove tehnologije 

uvijek za sobom povlači početničke greške. No sada imamo neko znanje i iskustva koja nam 

omoguduju da sljededi projekt napravimo mnogo brže i uz puno manje muke.  

Testiranje i debuggiranje ostaje problem, pogotovo za vede aplikacije, no očekujemo da de Google to 

riješiti u razumnom vremenu. Također očekujemo da se upute (tutoriali) za izgradnju robota 

poboljšaju.  

Postavlja se pitanje „ima li Google Wave bududnost?“. 

Wave svakako pruža mnoge mogudnosti za komunikaciju i suradnju. Tvorci su imali ambiciozne 

planove i mnogo ideja. Mogudnost izrade vlastite ekstenzije u obliku robota ili gadgeta je vrlo korisna 

i daje velike mogudnosti za korištenje. 

Na Wave aplikaciji se još treba raditi. Korisničko sučelje je pomalo nespretno, troši puno resursa, 

može se zamrznuti, a neke mogudnosti (koje koriste mnogo resursa) su nepotrebne. 

Ambiciozni planovi ipak imaju svoju cijenu. No, ovo je tek početak razvoja pa se očekuje da de se 

početni problemi riješiti. Svi imaju mogudnost sami poboljšati funkcionalnosti aplikacije Wave putem 

ekstenzija. Mogude je da, jer mnogo ljudi dodaje i mijenja dijelove, Wave postane nepregledan i 

nepogodan da se na njemu dalje radi. 

Mogudnosti aplikacije Wave trebaju se koristiti razumno, inače je Wave samo neefikasna igračka. 

Korisnicima koji znaju što žele, Wave de biti dobar saveznika u rješavanju njihovih problema. Google 

Wave nudi mnoštvo mogudnosti. Na korisnicima je da ih iskoriste, ili ne iskoriste. 

 

 


